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Automatic Document Detection Utility
Purpose

Use the Automatic Document Detection (ADD) Utility to configure the way the ADD feature
works.    The ADD Utility lets you turn the feature on or off and lets you control whether 
extended attributes are written to non-WordPerfect file types.    In addition, you can use 
the ADD Utility to provide double-click to open and drag-drop printing features for 
document types without an OS/2 native application.

The ADD Utility automatically registers your WordPerfect 5.x and 6.x document types.

Steps
To register non-WordPerfect document formats,
1 Open the WordPerfect Program folder, then double-click the ADD Utility icon.
2 Select a document type from the Available document types list box, then choose Add.
3 Choose OK.

See Also
Document Objects
WordPerfect Program Folder



Document Summary Information
Purpose

Use WordPerfect Document Summary information to view and sort attributes in the 
Settings view of all WordPerfect 6.0a for Windows objects.

Steps
To edit the document summary details,
1 Open the Settings page of a WordPerfect document object.
2 Type the new text you want into the Settings page (the changes will be automatically 

saved to the document).    The document summary can also be edited from WordPerfect 
6.0a for Windows.

3 Close the Settings page.

The document summary details can be seen in the Details view of a folder object.    Refer 
to the help information provided on the following Settings notebook pages of any folder 
object for further information about how to display, sort by, and include by the document 
summary details:

 View (page 3 of 3)
 Include (WordPerfect 6.0a Document Criteria page)
 Sort

You must select WordPerfect 6.0a Document in the Object type list box to activate the
use of the document summary details.



Drag and Drop Deleting
Purpose

Use Drag and Drop Deleting to delete WordPerfect document objects without opening 
WordPerfect 6.0a for Windows.

Steps
To delete a WordPerfect document object,
1 Open the folder containing the document object you want to delete.
2 Select the document object(s) you want to delete, drag the object(s) to the Shredder 

object, then release the mouse button.

See Also
Document Objects
Drag and Drop Colors
Drag and Drop Fonts
Drag and Drop Printing
Inserting a Document
Inserting Spreadsheets, Databases, and Graphics



Installing Under Win-OS/2 (SETUPOS2.EXE)
Purpose

Use SETUP.EXE and SETUPOS2.EXE to install the WordPerfect 6.0a for Windows and the 
OS/2 WPS Integration Tools files to your desktop.

Steps
To install WordPerfect 6.0a for Windows from the disk set,
1 Insert the Install 1 disk into drive A, then double-click the Drive A icon on the desktop.
2 Double-click the SETUP.EXE icon.
3 Follow the on-screen instructions.

No application that uses WordPerfect shared code can be running while installing 
WordPerfect (including QuickLaunch).

To install WordPerfect 6.0a for Windows from the network,
1 Go to the folder where the WordPerfect 6.0a for Windows files are located, then double-

click the SETUP.EXE icon.
2 Follow the on-screen instructions.

Network administrators must use OS/2 to copy WordPerfect to the network in order to
copy the extended attributes to the network.

After WordPerfect 6.0a for Windows is installed, use the following steps to install the OS/2 
WPS Integration Tools files to your desktop.
1 Insert the OS/2 WPS Integration Tools disk into drive A, double-click the Drive A object, 

then double-click the SETUPOS2.EXE icon.
2 Follow the on-screen instructions.
3 Close the Drive A folder, then reboot when SETUPOS2.EXE has finished running.

To install the OS/2 WPS Integration Tools disk to your desktop from the network,
1 Install the OS/2 WPS Integration Tools files to the Server install on the network.
2 Go to the folder where shared code is installed on the network, then double-click the 

SETUPOS2.EXE icon.
3 Follow the on-screen instructions.
4 Reboot when SETUPOS2.EXE has finished running.

See Also
Setup
Tips and Tricks



Associate OS/2 Printers with Windows Printers
Purpose

Use the Associate OS/2 Printers with Windows Printers dialog box to associate your 
Windows printer with your OS/2 printer.    This will let you use your OS/2 printer while in 
WordPerfect 6.0a for Windows.

Steps
To associate your printers for the first time,
1 Drag and drop a WordPerfect document object to an OS/2 printer (the Associate OS/2 

Printers with Windows Printers dialog box appears).
2 Select the Windows printer you want to associate with the highlighted OS/2 printer, then

choose Associate.
or... If the correct Windows printer is not displayed, choose Windows Printer Options, 
add the correct printer definition, select the new printer definition, then choose 
Associate.

To associate your printer from the Select Printer dialog box,
1 Choose Select Printer from the File menu, then choose OS/2 Printers (you will only see 

the OS/2 Printers option while running WordPerfect under OS/2).
2 Select an OS/2 printer from the OS/2 Printers list box, select a Windows printer from the 

Associated Windows Printers list box, then choose Close.
3 You can use Delete Association to delete the associations for selected OS/2 printers (the

printer definitions are not deleted), or use Windows Printer Options to add, delete, or 
edit Windows printer definitions.

See Also
Document Objects
Drag and Drop Printing
Tips and Tricks
WordPerfect Printers Folder



Tips and Tricks
This Help screen will give you more information about the following topics:

 Settings Configuration
 The /SW Startup Command
 Printing to the Network
 Possible Traps While Running in Win-OS/2
 Reinstalling WordPerfect Objects
 Corrupted .INI Files
 Moving Your Desktop from HPFS to FAT
 Your .BIF file Could Not Be Opened

Settings Configuration
Running WordPerfect 6.0a for Windows under OS/2 2.1 requires some configuration of the 
WordPerfect Program object's Settings notebook.    When you use SETUPOS2.EXE to install 
the WordPerfect Program folder, these settings are changed automatically.    The following 
settings are changed in the Win-OS/2 settings dialog box on the Session tab:

Setting Name Default Suggested
WIN_RUN_MODE STANDARD ENHANCED
DOS_FILES 20 100
DOS_HIGH OFF ON
DPMI_DOS_API DISABLED ENABLED
DPMI_MEMORY_LIMIT 4 128
IDLE_SECONDS 0 5
IDLE_SENSITIVITY 75/95 95
XMS_MEMORY_LIMIT 2048 6144+
WIN_CLIPBOARD ON ON
WIN_DDE ON ON

The /SW Startup Command
The /sw startup command is added to the SH_SH_.ENV file when you run SETUP.EXE.    If you 
are using a 256-color palette, this command will keep the background colors from changing 
while running WordPerfect.    If you are dragging and dropping colors, the colors may not 
display properly, but they will print properly.

Win-OS/2 settings and the /sw startup command are automatically changed when 
SETUPOS2.EXE is installed.

Printing to the Network
If you are having difficulty printing from the LPTx printer port when using a network printer, 
try using the corresponding LPTx.OS2 printer port.

To use a LPTx.OS2 printer port with a WordPerfect printer driver, you must print to a file 
using the filename LPTx.OS2.

Possible Traps While Running in Win-OS/2
If you experience a trap in WordPerfect 6.0a for Windows while running in seamless Win-
OS/2 mode, and you are using the QuickLaunch feature, you may end up with some 
WordPerfect 6.0a open view entries in your Window List that cannot be closed.    The 
operating system has not told the OS/2-Win-OS/2 communication mechanism that the 
WordPerfect 6.0a for Windows application is no longer running.    This problem has been 
reported to IBM.



You can resolve this problem by closing down all of your seamless Win-OS/2 applications, 
then closing down the QuickLaunch application.    This will shut down the seamless Win-OS/2 
session completely.    Once the seamless Win-OS/2 session has terminated, your system 
should be back to normal.

Reinstalling WordPerfect Objects
Try using the SETUPOS2.EXE program with the /fixwps option.    This will destroy and recreate
all objects from scratch and will remove any objects that no longer exist on the hard disk.

This option works around a known OS/2 problem in the object installation and has been 
reported to IBM.

Corrupted .INI Files
Use SETUPOS2.EXE with the /fixwps option to reinstall OS/2 .INI files that have become 
corrupted.    Also, if you use different Workplace Shell .INI files, you should use 
SETUPOS2.EXE /fixwps with each of those OS/2 .INI files in order to install the WordPerfect 
6.0a for Windows folder in each desktop you use.

Moving Your Desktop from HPFS to FAT
When running any Windows application in Win-OS/2 mode under OS/2 version 2.x, it is 
important to choose a disk format that will enable that application to run to the best of its 
ability.

With the FAT file system, all filenames and directory names have a maximum length of eight 
characters with a three-character extension (for example, FILENAME.EXT).

With the HPFS file system, any filename or directory name can be as long as 254 characters 
with more than three characters in its extension.

Any Windows or DOS application you run under OS/2 version 2.x will only be able to use files
with standard DOS filenames (as many as eight characters with a maximum three-character 
extension).    Any files with HPFS long names will be hidden from your Windows and DOS 
applications, including all files with a long subdirectory name.

Steps
To move your OS/2 desktop from one disk partition to another without having to reinstall 
the operating system,
1 Make sure you are using OS/2 version 2.1 or later.
2 Double-click the OS/2 System folder.
3 Double-click the Drives folder within the OS/2 System folder.
4 Double-click the disk object where you installed OS/2 (C: by default).
5 Look for your desktop directory in the tree hierarchy for that disk.    It should be called 

Desktop or OS!2 2.0 Desktop and have an office desk icon.
6 Once you find the desktop object, drag it to a FAT disk partition.
7 While your desktop is moving, do not reboot or open other objects. Once the move is 

complete, wait a few seconds while OS/2 writes all desktop link information back to your
hard disk.

The .BIF file could not be opened
If you get this error message during startup, place the SET 
RESTARTOBJECTS=STARTUPFOLDERSONLY command in your CONFIG.SYS file.

If you get this error message after startup, you probably have WordPerfect products running 
in separate Win-OS/2 sessions.    You cannot run WordPerfect products (including 
QuickLaunch) in more than one Win-OS/2 session because the .BIF file can only be used in 



one session at a time.



Templates
Purpose

Use templates to quickly create professional-looking newsletters, envelopes, fax cover 
sheets, letters, memos, and more.

Steps
To use a document template,
1 Double-click the WordPerfect Templates folder, then select the appropriate template.
2 Drag the template to another folder or to your desktop.

WordPerfect will open with the template in the document window.    If the template is an 
ExpressDoc, it will prompt you for information (for example, your name and phone 
number).    After you enter the information once, ExpressDocs will automatically merge 
this information into any ExpressDocs subsequently opened.

See Also
Document Objects
Opening WordPerfect from the Document Object
Templates Folder



WordPerfect Program Folder
Purpose

The WordPerfect Program Folder contains WordPerfect program objects and folders.

Steps
To run a WordPerfect program or open a WordPerfect folder,
1 Double-click the program object.

or... Double-click the WordPerfect folder.

To access help for each object located in this folder,
1 Select the object, then press F1.

or... Select Help from the object's context menu.

See Also
Automatic Document Detection Utility
Graphics Folder
Kickoff
QuickFinder File Indexer
Readme Folder
Setup
Speller
Templates Folder
Thesaurus
WordPerfect 6.0 Program
WordPerfect Printers Folder



WordPerfect Workspace
Purpose

Use the WordPerfect Workspace template to create work area folders ready to hold your 
WordPerfect documents.    A Workspace folder will open by default into Details view and 
already has the WordPerfect document details (Author, Typist and so on) selected.

Steps
To use the WordPerfect Workspace template,
1 Double-click the WordPerfect Program folder, then double-click the Templates folder.
2 Select the WordPerfect Workspace template, then drag and drop the template to 

another folder or your desktop.
3 Open the new Workspace folder by double-clicking it.    Note that it opens into Details 

view by default.

See Also
Templates
Templates Folder



Workplace Shell Integration
WordPerfect 6.0a for Windows integrates with the Workplace Shell in a seamless fashion.    
See the topics below for more information about the Workplace Shell features in 
WordPerfect. 
Associate OS/2 Printers with Windows Printers
Automatic Document Detection Utility
Document Objects
Document Summary Information
Drag and Drop Colors
Drag and Drop Deleting
Drag and Drop Fonts
Drag and Drop Printing
Inserting a Document
Inserting Spreadsheets, Databases, Graphics
Opening WordPerfect from the Document Object
Templates
WordPerfect Workspace



Document Objects
Purpose

A document object is a graphical representation of the saved document.    You can use the 
WordPerfect document objects from the Workplace Shell to open, print, and delete 
documents, databases, graphics, and spreadsheets.

If a WordPerfect document was not created in WordPerfect 6.0a for Windows, it will 
automatically be converted into a WordPerfect 6.0a document object the first time the 
folder containing the document is opened.    You can use the Automatic Document 
Detection Utility to convert files from other word processing programs into document 
objects.

Steps
To select a document object,
1 Click the document object with the left mouse button.

To select more than one document object,
1 Click the first document object with the left mouse button.
2 Hold down the Ctrl key, then select the next document object with the left mouse 

button.
3 Repeat step 2 until all document objects are selected.

To drag the document object(s),
1 Select the object(s), press and hold the right mouse button, then move the object(s) to 

the desired location. 

See Also
Automatic Document Detection Utility
Drag and Drop Deleting
Drag and Drop Printing
Inserting a Document
Inserting Spreadsheets, Databases, and Graphics
Opening WordPerfect from the Document Object
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Graphics Folder
Purpose

The Graphics folder contains predefined WordPerfect graphics.

Steps
To use a graphic from the WordPerfect Graphics folder,
1 Double-click the WordPerfect Graphics folder, then select the appropriate graphic.
2 Choose from the following options for more information:

Drag and Drop Printing
Opening WordPerfect from the Document Object
Inserting Spreadsheets, Databases, and Graphics

See Also
WordPerfect Program Folder



Templates Folder
Purpose

The WordPerfect Templates folder includes over 70 ExpressDoc templates for newsletters, 
envelopes, fax cover sheets, letters, memos, and more.    ExpressDocs are automated and 
will prompt you for necessary information (for example, your name and phone number).

Steps
To open the Templates folder,
1 Double-click the Templates folder.

See Also
Templates
WordPerfect Program Folder



WordPerfect Printers Folder
Purpose

The WordPerfect Printers folder will contain printer objects for all WordPerfect printer 
drivers found in your private and public .BIFs, and all Windows drivers found in your public
.BIF.    The WordPerfect Printers folder will be updated each time WordPerfect is invoked.

Windows drivers located in your private .BIF are automatically mapped to the nearest 
compatible OS/2 printer driver using the Associate OS/2 Printers with Windows Printers 
dialog box.

You can move printer objects out of the WordPerfect Printers folder or create a shadow of 
the printer object.    Printers are permanently added or deleted from your WordPerfect 
Printers folder as you add and delete printer definitions from the Select Printer dialog box 
in WordPerfect.

Steps
To open the WordPerfect Printers folder,
1 Double-click the WordPerfect Printers folder.

If you delete the WordPerfect Printers folder, all printer objects found in your private 
and public .BIFs will appear on the desktop each time WordPerfect is invoked.    If the 
WordPerfect Printers folder is deleted, you must use SETUPOS2.EXE /wps to restore it.

See Also
Associate OS/2 Printers with Windows Printers
Drag and Drop Printing
Reinstalling the WordPerfect Program Folder



Speller
Purpose

Use Speller to check your document for misspelled words, two occurrences of a word in a 
row, and certain types of capitalization errors. You can check a word, page, document, or 
selected text.

You can also look up words phonetically or display all the words in the dictionary that 
match a pattern.

Steps
To open the WordPerfect Speller,
1 Double-click the Speller object to start WordPerfect Speller.

or... Choose Speller from the Tools menu while in WordPerfect.

Speller is a stand-alone application, which means you can run it under Win-OS/2 without 
running WordPerfect.    When you run it in stand-alone mode, you can only look up 
words--you cannot spell-check a document.

See Also
Thesaurus



Thesaurus
Purpose

Use Thesaurus to search for and display synonyms (words with the same or very similar 
meaning) and antonyms (words with the opposite meaning) of words in your text or words 
you type from the keyboard.

Steps
To open WordPerfect Thesaurus,
1 Double-click the Thesaurus object to start WordPerfect Thesaurus.

or... Choose Thesaurus from the Tools menu while in WordPerfect.

Thesaurus is a stand-alone application, which means you can run it under Win-OS/2 
without running WordPerfect.    When you run it in stand-alone mode, you can only look up 
words--you cannot use it with a document.

See Also
Speller



KickOff
Purpose

Use KickOff to automatically start any program at a certain time during the day.

Steps
To setup KickOff,
1 Double-click the KickOff object, then choose Add.
2 Type the path and program name of the program you want to automatically start.

or... Choose Browse, select the directory and filename of the program you want to 
automatically start, then choose OK.

3 Enter the date and time the program will first begin in the Start Time group box.
4 If desired, enter the time for the program to be opened again in the Repeat Interval 

group box. 
5 Choose OK.

To run KickOff,
1 Double-click the KickOff object.

or... Copy the KickOff object to the Startup folder and KickOff will run every time you 
start OS/2.



Drag and Drop Colors
Purpose

Use your OS/2 Color Palette to change text colors in your WordPerfect document.

Steps
1 Select the text you want to color.

or... Place the insertion point where you want the color change to begin.
2 Open the OS/2 Color Palette, then select a color.
3 Drag the color to the WordPerfect document window, then release the mouse button.
4 Close the OS/2 Color Palette.

See Also
Document Objects
Drag and Drop Deleting
Drag and Drop Fonts
Drag and Drop Printing
Inserting a Document
Inserting Spreadsheets, Databases, and Graphics



Drag and Drop Printing
Purpose

Use Drag and Drop Printing to print a WordPerfect document without opening WordPerfect 
6.0a for Windows. 

Steps
1 Open the folder containing the document object you want to print.
2 Select the document object, drag the object to a printer object, then release the mouse 

button.

WordPerfect 6.0a is a Windows application.    To print from a Windows application using an 
OS/2 printer object, an OS/2 printer must be associated with a Windows printer.    The 
Associate OS/2 Printers with Windows Printers dialog box will let you associate your 
Windows printer with your OS/2 printer.

See Also
Associate OS/2 Printers with Windows Printers
WordPerfect Printers Folder



Inserting a Document
Purpose

Use this feature to insert one or more document(s) into a new document window or into 
the current document.

Steps
1 Place the insertion point at the location you want the document(s) to be inserted.
2 Select the document object(s) you want to insert.
3 Drag the object(s) to your document, then release the mouse and key(s).

Use the following mouse and keystroke commands to change the way a document is 
inserted.

Mouse and Keystrokes Result
Drag and Drop Inserts the document into a new WordPerfect 

document window
Ctrl+Drag and Drop Inserts the document into the current document
Ctrl+Shift+Drag and Drop Inserts a subdocument link into the current 

document

See Also
Document Objects
Inserting Spreadsheets, Databases, and Graphics



Inserting Spreadsheets, Databases, and Graphics
Purpose

You can insert a spreadsheet, database, or graphic into a WordPerfect document by 
dragging and dropping the spreadsheet, database, or graphic onto a WordPerfect 
document window.

Steps
1 Place the insertion point at the location you want the spreadsheet, database, or graphic.
2 Select the spreadsheet, database, or graphic object you want to insert.
3 Drag the object to your document, then release the mouse and key(s).

Use the following mouse and keystroke commands to change the way a document is 
inserted.

Mouse and Keystrokes Result
Ctrl+Drag and Drop Inserts the spreadsheet, database, or graphic 

into the current document
Ctrl+Shift+Drag and Drop Inserts a data-link to the spreadsheet, 

database, or graphic (in the current document)

See Also
Inserting a Document



Opening WordPerfect from the Document Object
Purpose

Use the document object to open WordPerfect with the document in the document 
window. 

Steps
1 Double-click the object.

or... Drag and drop the document object to the WordPerfect Program object.

See Also
Document Objects
Inserting a Document



Drag and Drop Fonts
Purpose

Use your OS/2 Font Palette to change the font in your WordPerfect document.

Steps
1 Select the text you want to change.

or... Place the insertion point where you want the font change to begin.
2 Open the OS/2 Font Palette, then select a font.
3 Drag the font to the WordPerfect document window, then release the mouse button.
4 Close the OS/2 Font Palette.

If you wish to use the drag-drop font feature, you must first install your ATM fonts in 
the Win-OS/2 environment.    Do this using the ATMCNTRL.EXE installed by OS/2 in your \OS2\
MDOS\WINOS2\ directory.

See Also
Document Objects
Drag and Drop Deleting
Drag and Drop Colors
Drag and Drop Printing
Inserting a Document
Inserting Spreadsheets, Databases, and Graphics



Reinstalling the WordPerfect Program Folder
Purpose

Use SETUPOS2.EXE /wps to reinstall the WordPerfect Program folder to the desktop.

Steps
To reinstall the WordPerfect Program folder, 
1 Open an OS/2 window.
2 Enter setupos2.exe /wps, then follow the on-screen instructions.

See Also
WordPerfect Program Folder



WordPerfect Programs and Folders
When the OS/2 WPS Integration Tools disk is installed, the following WordPerfect programs 
and folders are found in the WordPerfect Program folder:
Automatic Document Detection Utility
Graphics Folder
KickOff
QuickFinder File Indexer
Readme Folder
Setup
Speller
Templates Folder
Thesaurus
WordPerfect 6.0 Program
WordPerfect Printers Folder

See Also
Installing Under Win-OS/2 (SETUPOS2.EXE)
Reinstalling the WordPerfect Program Folder
WordPerfect Workspace



QuickFinder File Indexer
Purpose

Use QuickFinder to create, edit, search, or update directory and file indexes.    Use 
QuickFinder when you need to find a particular word or phrase quickly.

QuickFinder is a stand-alone application, which means you can run it under OS/2 without 
running WordPerfect.

Steps
To open QuickFinder,
1 Open the WordPerfect Program folder.
2 Double-click the QuickFinder File Indexer object.

See Also
WordPerfect Program Folder



Readme Folder
Purpose

Use the Readme folder to get information about WordPerfect not found in the WordPerfect 
6.0a for Windows Reference or online Help.

Steps
To view a Readme file,
1 Open the WordPerfect Program folder.
2 Open the Readme folder, then double-click the appropriate Readme document object.

See Also
Tips and Tricks
WordPerfect Program Folder



WordPerfect 6.0 Program
Purpose

Use the WordPerfect 6.0 program object to start WordPerfect 6.0 for Windows.

Steps
To open WordPerfect,
1 Open the WordPerfect Program folder.
2 Double-click the WordPerfect 6.0 program object.

See Also
WordPerfect Program Folder



Setup
Purpose

Use Setup to install or uninstall all or part of the WordPerfect 6.0 for Windows program.

Steps
1 Open the WordPerfect Program folder, then double-click the Setup icon.
2 Choose Install, then choose an option from the Installation Type group box.

or... Choose Standard to uninstall the entire WordPerfect 6.0 for Windows program.
or... Choose Custom to uninstall selected parts of the WordPerfect 6.0 for Windows 
program.

Uninstall will not delete OS/2 WPS Integration Tools files.

See Also
Installing Under Win-OS/2 (SETUPOS2.EXE)
WordPerfect Program Folder




